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Introduction
Embedded System ESP32 DEV KIT V1 Microcontroller:

Overview:

| ESP32 DEV KIT V1 WL\ eIlig

[“Tnput only | [[RTCGPI0S | [SERENNY (ADC1_3| [T IEl— (3= , ~ALH oo FekE

[[Input only | [RTC1GPIO4 ] (ADC1_6] [ FT— veiofceos]  f |

IBAGHN [ RC Gpioe | (Aocz_s [ Ty« (R © _ ~vA M I (V-SPLCS0] (187
[RTCGPIOL4] (Toucha || HSPI_iD | [ADC2_4] [T -\ (308 " K R oA F71 (11| [ADC2_3] [ HSPI_CS0 || Touch3 | [RTC GPIO13]
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[ www.mischianti.org

The ESP32 is a low-cost, high-performance microcontroller developed by Espressif Systems. It is widely used in
IoT, automation, and embedded systems due to its integrated Wi-Fi, Bluetooth, and high processing capability.

Pin Name Type Function / Description
Chip enable pin; active HIGH to
B Centrgl enable ESP32
VIN —_— 5V input from USB or external
power supply
3.3 V regulated output from
W3 Power on-board regulator
GND Power Ground
General-purpose 1/0; used for
GHI00 e boot mode selection
GPIO1 (TX0) UART UARTO transmit pin (serial
autput)
GPIO3 (RX0) UART UHTD receiveipin LTl
input)
General-purpose I/0; supports
GMO2, GPIO4 Vo PWM and digital 1/0
GPIO12 — GPIOTS 1o ADC, touch sensor, PWM, and
general-purpose I/O
UART2 TX/RX or general-
GPIO16 - GPIOL17 /0 purpose digital 1/O
GPIO18 - GPIO19 1o SPI clock and MISO or general-
purpose 1/0
i =
GPI021 — GPIO23 /o I*C {SDA/SCL) or general
purpose /0
DAC, ADC, PWM, and digital
GPIO25 - GPIO2T7 f]e] /O supported
GPIO32 — GPIO33 /o ADC, touch sensor, PWM
supported
GPIO34 — GPIO39 Input Only Input-only pins; ADC and touch
sensor supported
AMOTECH Embedded/loT Development | Automation Sevices | Training & Counselling
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Universal Development Board(UDB)
One Development for
Studying Embedded Systems | Project Development | Product Prototyping

on below multiple Microcontrollers
8051 Shield & PIC18F/16F Dev. Boards | Arduino Uno | ESP32 Devkit V1 | Arduino/STM32 Nano Boards

Slot 1- Arduino Uno Boards / 8051 & PIC Dety. Boards by Amotech Labs

5V DC INPUTS Slot 2 - ESP32 Devkit
(DC Jack/USB C) 1

SR-04 Ultrasonic
Sensor Slot

Slot 3-
Arduino Nano

- ﬁ
1] L

f = yuf |

e E e S DS 1307 RTC/2C
] — [[5P32 Devkit v1—1;— o D:.a" e Module Slot
| -nt 1 Sle | Slot 3 SN
i ARDUINO MANO
| .Hl Gua ME'I':I!M’DSEELH |
X _IREF L 3
0 =2 =z
L.
e s
3 Relays % .gZ 5 SD Card/SPI
(for240VAC [ ) b < Module Slot
- I_: = { 4
Devices Control) GEge ;
S 5ch -3
LA
2 g3
il ]
b Sé |
E ﬁu J| "'I'r- T v
= ¥ E N T SIM800L GSM/
=z =1
S af 00 = UART Module Slot

e - -

2 DC Motor Conn.

Wlth L239D |C Base sl ! L :— b L 2 Servo Motor
.. 3 B% s GH =3 Connectors
1 Stepper Motor : = RYL A0 SERVO 3, | D1y 3f
pp ® o A o vZ) | A1 L Ay (o e g | RF Transmitter
Connector , T A RY A2[ il 1 N Module Slot
: > " pot" " " RYO 2 D9 W3 [
10kPot. LM35 Slot | | C e o b oy | DO e |y 8 RF Receiver
or Analo 8 b7 - |
- i UNIVERSAL DEV. BOARD —— ™ = Module Siot
Leslaid & Mfg. by:
4Push Buttons DsiT WWW.AMOTECHLABS.COM ®

for Digital Inputs
(2 on each side)

LCD Contrast.| |16x2 LCD
Control Pot. Connector

Below Microcontroller Shields/Boards can be inserted into UDB and interfaced with all above Peripherals on it

Slot 1 Slot 2 Slot 3
Ardui STM32FO/F4 8051 & PIC18F/16 8051 & PIC18F/16 l ESP32 | | Arduino STM32 Nucleo  Arduino
rduinoUno  yycleoBoards Mini Dev. Boards Dev. Boards Devkit V1 Nano Nano NanoRp204O
by Amotech Labs by Amotech Labs a9 afi . Al
e Development
Boards/Shields
in Arduino Nano
Footprint
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Universal Development Board(UDB) kit
For Students

Universal Development Board(UDB)

+
UDB 2 Wheel Robot Acrylic Sheet

This includes below two items as shown in the below

1- Universal Development Board(UDB) 2- UDB 2 Wheel Robot Acrylic Sheet
(used for mounting UDB and also PIC
& 8051 boards hy Amotech Labs)
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Note: ‘UDB 2 Wheel Robot Acrylic Sheet’ can be used to hold UDB and mount it on any other
platform to use it for multiple Applications. It can be also converted into Robot by
attaching 2 DC motors with wheels at it's back and 1 omni wheel at front.

Refer UDB Manual or our Reference YouTube videos to see how it can be used

as bot.
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Sharing Enthusiasm for Embedded Systems & Automation.

UDB 2 Wheel Robot Acrylic Sheet

Omni Wheel mounting Holes

1 2

DC Motor 2
mounting Slot
using Cable Ties

DC Motor 1
mounting Slot
using Cable Ties

5 6
UDB & PIC/8051 Development Boards Mounting Instructions :

Universal Development Board : Use holes 1,2,5 & 6 for mounting UDB on above Acrylic Sheet.
PIC & 8051 Dev. Boards: Use holes 3,4,5 & 6 for mounting PIC18F/16F & 8051 Development Boards.

After Mounting Omni Wheel & 2 DC Motors along with their wheels

e

Backside View of Acrylic Sheet after mounting
Omni Wheel and 2 DC Motors with their Wheels.
Omni wheel is mounted using 10mm spacers
with M3 nuts and DC motors can be mounted
using Cable ties.

Front View of Acrylic Sheet after mounting
Omni Wheel and 2 DC Motors with their Wheels.
Now, on top ‘UDB’ and PIC/8051 Development
Boards can be mounted.
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Sharing Enthusiasm for Embedded Systems & Automation.

Assembled ‘UDB 2 Wheel Acrylic Robot Sheet’
with UDB & 8051/PIC Boards

‘Universal Development Board(UDB) mounted on assembled Robot Sheet

L293D Motor Driver IC
slot and 2 DC motor
connectors can be used
for driving 2 DC Motors
using UDB

16 Pin DIP/L293D Motor Driver IC
slot and 2 DC motor connectors

can be used for driving 2 DC

Motors using PIC18F/16F Dev. Board
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Universal Development Board(UDB) kit
UDB Mounted in Wooden Box Enclosure with on board DC, Servo & Stepper Motors

Universal Development Board(UDB) + ESP32 Devkit V1

Video Description [E] 2

AM DTEEH LABS%t’T‘ﬁ?"u

Sharing Epthusiasm for Embedded Systems & Automation. | x o be. com/ ]t :
Embedded Symiamad Industrial Automation & Robotics |Training & Counselling| @amotechLabs
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EVELOPH 30ARD (UDB) |
Studying Embedded Systems & Project/Product Developmen
1 0 on multiple 8 & 32-Bit MCU ;
[ | u 80 Sr’lﬁﬂl m;lBFHﬁlf.bSE!llold | Arduino Uno | ESPBI:? Devkit V1 | Arduino Nano Boards | STM32 Nano boards -
AMOTECH LABS, Pune = d

In above Kit, UDB is mounted on a sheet in a Wooden Enclosure Box along with DC, Servo

and Stepper Motors. The ESP32 Devkit V1 must be attached to UDB to it’s Slot 2 as seen in
the Picture above.
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Sharing Enthusiasm for Embedded Systems & Automation.

To study & understand the ‘Universal
Development Board (UDB)’ schematic visit
our website for its Reference material, and
also refer to our Youtube channel for video

tutorials for more understanding

Website Link:

https://www.amotechlabs.com/

For Youtube Tutorial:

Scan for Video Tutorials

https://www.youtube.com/@Amotechlabs
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User Guide for UDB So ware
Steps for use of Arduino IDE

1. Double click on Arduino IDE icon on the desktop

& sketch_cct2Ta | Arduing IDE 2.5.6

File Edit &

2. To create new project. Select File -> New Sketch

skebeh_ect27a | Arduine IDE 235 - =] x

Fille Edit Sketch Tools Help

New Sketch CirleN 32 DEVKIT 1

Open. CuleD It
Open Recent ¥
Bxamples 3
Close
Save 1+5§
Save s ChrlaShift=5
Preferences Cted+Comma
Advanced ¥

Clui
Clust

In1,Col 1 DOIT ESP32 DEVKIT V1 on COM3 [not connected] 01
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3. Save the sketch
Menu — File — Save

& Blink | Arduine IDE 2.3.6 - o X

File Edit Sketeh Tools Help

New Sketch
Open Cted+0
Open Recent ¥
Examples 2
noe ¢
Swve Ctrl+5
Save As
Prafarances Cird+Comma
Acvanced 3
Qu Q
26
7
2 UILTI QUTH
.

4. Select the board
Tools — Board — {Your board type, e.g. Arduino Uno}.

& ESP32_Schedule | Arduing IDE 2.3.6 - [u] %
File Edit Sketeh Tosls Help
- * Domeses: oevar v - —
El BOARDS MANAGER ESP32_Scheduleino =
Filker your search... 23 sy ey Sy o ———
a4
Select Other Board and Port
| = e A ks as

46
mh Arduino AVR Boards by I a7
Arduing 48

186 installed a3 T
5'.} Boards included in this package: ol
Arduing Micrs, Arduing Fio, 51 = x

LityPad Arduino USB, Arduing... 52 aaassalil

Q Mare info 53

186 w REMOVE :': =
56 a e
57
o 58 A
Arduino ESP32 Boards -
by Arduing 58
Boards included in this package: E1
Arduino Nana ESP32 =
Mare info

2018 v oup &
<

Arduine Mbed OS Edge
Boards by Arduing
Boards included in this package:

@ Arduino Edge Control
Mare info
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5.Select the port
Tools — Port - COMx

& Blink | Arduing IDE 2.3.6 = a x

File Edit Sksten Took Halp

Blink.ino o Unknown
COME

16

g Unknown

11 Select other board and port..

26 wvoid setup() {

28 pinMode(LED_BUILTIN, OUTPUT);
29 by

32 woid loop() {
33 digitalWrite (LED_BUILTIN, HIGH):
8e);
rite(LED_BUILTIN, LOW);
lay{1080);

6.Install/Include libraries (if needed) Sketch — Include Library — Manage Libraries

& Blink | Arduing IDE 2.36 _ - a »
Marage Libtaries.  Ctrl+Shift+]

File Edit Sketch Tool Help

m I-.tnf}.l.:omp:le Eem Add EIP L:?!‘ar:l..

Upload Ctrd+l)

Arduine hbranes
Configure and Upload

Arguina_Builin
Upload Using Programmer Ctrl« Shift«Ll

Arduino0OTA
Export Compiled Binary Alr+Cerd=5

BLE
Optimize for Debugging
BluetoothSerial
Show Sketch Folder Alt=Ctri= K DihEServer
Inctude Libeary » EEFROM
Add File.. ESP Insights L
— ESP RanMaker
e is example io n i
ESP_I25
21 s
22 https: -ar ing. E ESP_NOW
23
gt
24 ESP_SR
25 th t fur n ESP3Z
void zetuni’
26 wvoid setup() { 5832 fsyme UDP
7 itiali lig r
28 pintiode (LED_BUILTIN, OUTE ESPmDNS

Ethermnet

Hash

MTTPClient

Ln13,Col 22  DOIT ESP32 DEVKIT V1 on COM3 [not connected] 0

AMOTECH Embedded/loT Development | Automation Sevices | Training & Counselling
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7. Write or paste code

& Efink | Arduing IDE 236 = =} =

File Edit Sketch Tools Help

¥ DOIT ESPIZ DEVKIT V1 - e ¢

4
Bk inG

[ I
18 1
11
12 4
13 f H 1 <
14
15 +
18 ;

17

Lm 13, Cod 22 DONT ESFA2 DEVIIT W1 on COME fnot connected] 01

8.Verify (compile)

& Blink | Arduing IDE 236 - =} x

File Edit Sketch Tools Help
1
m Verify/Compile CileR = Mol
B Uplcad Ctri+U 523
Configure and Upload

Uglcad Using Programmer Ctrl«

Export Compiled Binary

Optimize for Debugging

Show Sketch Folder Alt=Ctri= K
Include Library ¥

Add File.,

OUTRUT) ;

22 DOIT ESP32 DEVKIT V1 on COM3 [nat connected] [
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9.Upload to board

& Blink | Arduing IDE 236

File Edit Sketch Tools Help
|
VerifpCompile CirleR - N ok
g Vslesd Ctri el
Configure and Upload

Uplead Using Programmer Cirl+5hift=U

Export Compiled Binary

Optimize for Debugging

Show Sketch Folder Alt+Ctri=K
Include Library -
Add File..
1y
e
21
22
23
24
25 J
26 wold setup()
27 digi E I
28 pin#ode (LED_BUILTIN, OUTPUT);
22 3} |

32 void loop() {
33 dig rite(LED_BUILTIN, HIGH); turn the f (HIGH the ltape 3l ] 1
1068@); vai

g rite(LED_BUILTIN, LOW);
36 delay(100@);

DEVEIT W1 on COM3: [not conmected)

10.0pen Serial Monitor
Tools — Serial Monitor or press Ctrl+Shi +M.

& Bink | Arduino IDE 2.3.6

File Edit Sketch Tools Help

Archive Sketch

Blink.ino
] Manage Librarias. Cerl+Shift=|
!: Sernial Monitor CtrleShift=M
11 Serial Ploteer
12
N Firenware Updater {
14
1% Upload S5L Root Certificates
16
‘
17 Board: "DOIT ESP32 DEVKIT V1° »
13
e Port: "0OM3" s [
L] Feload Board Data !
21 : .
Gat Board |
23 Get Board Info e
3
24 Core Debug Level: "None™ ¥ !
2: Erase Al Flash Before Sheteh Uplosd: “Disabled” y | PORECTENE Dagy |
Serial Mo Flash Freguency: “80MHz™ ¥ = "'

Programener H]

Burn Bootiader ‘

=

Ln37,Col2 DOIT ESPE2 DEVKIT V1 on COMS not connected] 0 B
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11. Below is the Final setup Example picture

2 e C\sersvanirudhatappbat a\Lecal Varduinol5hpackageshespi2\tool s\espl2-arduing - 1ibs\idf -release_vws.5-07edbfid
5 LuidCrys y1yespaziine lude\newl ib\platform_include\time.h
El ar® s5id = “amotech Labs™;
18 const char® password = “123456789%;
11
12
13 "in.pool.ntp.org”;
14 it H
15 SR a;
16
17
18
19
8
21
2
73
24
iFi™y

Ee=o

=

5 DOITESP32 DEVKITVioncoM? 32 B3
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LABS Embedded Development Boards/Kits | PLC & Automation Training Stations 15

ﬁb www.amotechlabs.com Q +91-8329537565 ™} amotechlabs@gmail.com



AMOTECH LABS

Sharing Enthusiasm for Embedded Systems & Automation.

Experiment 1
LCD Interfacing

Aim:LCD Interfacing with ESP32 using UDB.

Circuit Dig: Type-A
program pin
(For ESP32)

ESP32
microcontroller

16X2 LCD
Display

Procedure:
1. Open the Arduino IDE and follow the procedure mention in above section “Steps for use
Arduino XIDE Software”.
2. Connect the power supply to board 1.e. 3.3v.
3.Make all necessary connections as per above diagram.
4. Write and Upload the program into the ESP32 using Type-A cable.

5.0bserve the output

Embedded/loT Development | Automation Sevices | Training & Counselling
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Program:

// include the library code:
#include <LiquidCrystal.h>

/f initialize the library by associating any needed LCD interface pin
/f with the arduino pin number it is connected to

const int rs = 13, en = 12, d4 = 14, d5 = 27, d6 = 26, d7 = 25;
LiquidCrystal lcd(rs, en, d4, d5, dé, d7);

void setup() {
/f set up the LCD's number of columns and rows:
lcd.begin(16, 2);
{/{ Print a message to the LCD.
led.print("Amotech Labs™);

h

void loop() {
// set the cursor to column 8, line 1
/f (note: line 1 is the second row, since counting begins with @):
lcd.setCursor(@, 1);
/f print the number of seconds since reset:
led.print({millis() / 1008);

¥
Embedded/loT Development | Automation Sevices | Training & Counselling
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Experiment 2
DC Motor Interfacing

Aim: To study the interfacing DC Motor Control using ESP32 with UDB and observe the output.

Circuit Dig:
Type-A
External power program pin DC Motors
supply (For ESP32)

DC Motor
driver
Connectors

Procedure:

1. Connect the DC motor to the motor driver module as shown in the circuit diagram.
2.Connect the motor driver control pins to the appropriate GPIO pins of the ESP32 Dev Kit.
3.Provide external power supply to the motor driver as required by the DC motor rating.
4.Connect the ESP32 Dev Kit to the computer using a USB cable and open the Arduino IDE.
5.Select ESP32 Dev Module and the correct COM port from the Tools menu.

6.0pen the DC motor control program.

7.Compile and upload the program to the ESP32 Dev Kit.

8.0bserve the DC motor operation after successful upload.

9. Verity the direction of rotation and speed control.

Embedded/loT Development | Automation Sevices | Training & Counselling
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Program:
1 const int POT_input = AS; f* assign ADC Channel */
2 bool di = HIGH;
3 bool d2 = LOW;
4  #include <LiquidCrystal.h>
5
6 / initialize the library by associating any needed LCD interface pin
7 ff with the arduino pin number it is connected to
a2 const int rs = 13, en = 12, d4 = 14, dS = 27, d6 = 26, d7 = 25;
9 LiquidCrystal lcd(rs, en, d4, d5, d6, d7);
1@
11 void setup() {
12
13 f/ set up the LCD's number of columns and rows:
14 led.begin(l6, 2);
15 ff Print a message to the LCD.
15 led.print(“amotech Labs™);
17
18 pinMode (15, QUTPUT); /* Motor 2 control pin 1 - Marked as A8 on UDB*/
19 pinMode(2, OUTPUT); /* Motor 2 control pin 2 - Marked as Al on UDB*/
28 pinMode(32, QUTPUT); /* Motor 1 control pin 1 - Marked as A2 on UDB *f
21 pinMode(4, OUTPUT); /* Motor 1 control pin 1 - Marked as A3 on UDB*/
22 J// attachInterrupt(digitalPinToInterrupt(1l), motor, RISING); /* Interrupt on falling edge on pin 2 */
23}
24
25  woid loop() {
26 int pwm_adc;
27 /f pwm_adc = analogRead(POT_input); /* Input from Potentiometer for speed control */
28 digitalWwrite(15,HIGH); /* Rotate Motor 2 in Anti Clockwise */
29 digitalwrite(2,L0W);
e
31 digitalwrite(32,HIGH); /* Rotate Motor 1 in Anti Clockwise */
32 digitalwrite(4,L0W);
33
34 delay(5e08);
35
36 digitalwrite(15,L0W); /* Rotate Motor 2 in Clockwise */
a7 digitalWrite(2,HIGH);
38
39 digitalWwrite(32,L0W}); /* Rotate Motor 1 in Clockwise */
48 digitalWrite(4,HIGH);
41 delay(5008);
42 /f analogirite(3, pwm_adc / 4);
43 )}
a4 /e
45 void motor(){
45 di = !di;
47 d2 = !d2;
48 _delay ms{288);
49 jadl
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Experiment 3
Relay control Interfacing

Aim: To study the Relay Control using ESP32 with UDB and observe the output.

Circuit Dig:
Type-A
s DFOZTAm pin
External power (For ESP32)
supply

Procedure:

1. Connect the relay module to the Universal Development Board (UDB) as shown in the circuit diagram.

2.Connect the relay control input pins to the corresponding GPIO pins of the ESP32 Dev Kit using
jumpers.

3.Provide the required external power supply to the relay module.

4.Connect the ESP32 Dev Kit to the computer using a USB cable (Type-A) and open the Arduino IDE.

5.Select ESP32 Dev Module and the correct COM port from the Tools menu.

6.0Open the relay control program.

7.Compile and upload the program to the ESP32 Dev Kit.

8.Observe the relay ON/OFF operation.
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Program:

f// include the library code:
#include <LiquidCrystal.h>

// initialize the library by associating any needed LCD interface pin
/f with the arduino pin number it is connected to

const int rs = 13, en = 12, d4 = 14, d5 = 27, d&6 = 26, d7 = 25;
LiquidCrystal lcd(rs, en, d4, d5, d&, d7);

//int Relayl = 15; f /D8

//int Relay2 = 2; /D@
//int Relay3 = 32; /D2
int Relayl = 15; J /D8
int Relay2 = 2; / /DB

int Relay3 = 32; fiD2

void setup() {

{/f set up the LCD's number of columns and rows:
lcd.begin(16, 2)j|

{{ Print a message to the LCD.
led.print("hello, world!™);

pinMode(Relayl, OQUTPUT);

pinMode(Relay2, OUTPUT);

pinMode(Relay3, OUTPUT);

digitallirite(Relayl,LOW);
digitallirite(Relay2,LOW);
digitallirite(Relay3,LOW);

void loop() {
[/ set the cursor to column @, line 1
{/f (note: line 1 is the second row, since counting begins with 8):
lcd. setCursor(@, 1);
/f print the number of seconds since reset:
led.print(millis() / 1eee);
digitallirite(Relayl,HIGH);
digitallirite(Relay2,LOW);
digitallirite(Relay3,HIGH);
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delay(2808);

digitalWrite(Relayl, LOW};
digitallrite(Relay2,HIGH);
digitalWrite(Relay3,LOW);

delay(2888);
digitallrite(Relayl,HIGH);
digitallrite(Relay2,HIGH);
digitalWrite(Relay3,LOW);
delay(2888);
digitalWrite(Relayl, LOW);
digitalWrite(Relay2,LOW)};
digitalWrite(Relay3,LOW);

delay(2888);
¥
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Experiment 4
Servo Motor Interfacing

Aim: To study the interfacing Servo Motor using ESP32 with UDB and observe the output.

Circuit Dig:
External Power
vz Supply Jumper (Step
Servo Voltage)
10K Pot
Servo Motor
10K Pot
Jumper
Procedure:

1. Connect the servo motor signal pin to a suitable GPIO pin of the ESP32 Dev Kit as shown in the circuit diagram.
2. Provide an external 5 V power supply to the servo motor and connect the ground to ESP32 GND.

3.Connect the ESP32 Dev Kit to the computer using a USB cable and open the Arduino IDE.

4.Select ESP32 Dev Module and the correct COM port from the Tools menu.

5.0pen the servo motor control program.

6.Compile and upload the program to the ESP32 Dev Kit.

7.0bserve the servo motor movement after successful upload.

8. Verify the angular position and direction of rotation.
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Program:
1 #include <ESP32Servo.h»
2 #include <LigquidCrystal.h>
3
Y £ LCD -------=-- #
5 const int rs = 13, en = 12, d4 = 14, dS 27, d&6 = 26, d7 = 25;
6 LiquidCrystal lcd(rs, en, d4, d5, de, d7);
7 long stepCount = 8;
a8
g servo myservo; /* create servo object to control a servo */
1@
11 int potpin = 4; /* analog pin used to connect the potentiometer */
12 int wal; /* wvariable to read the value from the analog pin */
13
14 void setup() {
15 Serial.begin(968@);
16 myservo.attach(33); /* attaches the servo on pin 9 to the servo object */
17
18 ff-=--==--- LCD INIT (ADDED) --------
19 lcd.begin(16, 2);
28 led.print("Servo Angle:™);
21}
22
23 wvoid loop() {
24 val = analogRead(potpin); /* reads the value of the potentiometer (wvalue between @ and 1823) */
25 Serial.print("Analog Value : ");
26 Serial.print(val);
27 Serial.print{"\n");
28
29 val = map(val, 8, 1823, @, 188); f* scale it to use it with the servo (value between @ and 188) */
3a serial.print("Mapped Value : ");
31 Serial.print(val);
32 Serial.print(”\n\n");
33
34 myservo.write(val); /* sets the servo position according to the scaled value */
35
36 r-——-- LCD UPDATE (ADDED) --------
37 lcd.setCursor(e, 1);
38 led.print("Angle: ");
39 led.print(val);
48 led.print({char)223); {/ degree symbol
41 led.print(™ "); f{ clear leftover characters
42
43 delay(2e8); /* waits for the servo to get there */
a )
45
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Experiment 5
Stepper Motor Interfacing

Aim: To study the interfacing Stepper Motor Control using ESP32 with UDB and observe output

Circuit Dig:

L]
. Llhl : dded § - -
52:3:::1.35, |a ﬁmi nmiﬂ? ourml“ll mulhrb:m’!
DS1307 RTC
Module
External Power
RELAY 1 |
Supply Jumper (Step

&0 Card
Module

Servo Voltage)

Stepper Motor | SIM800L

GSM

Controller Module

Stepper Motor

Jumpers

tepper Motor

Procedure:
1. Connect the stepper motor to the stepper motor driver module as shown in the circuit diagram.
2.Connect the driver control pins to the appropriate GPIO pins of the ESP32 Dev Kit.
3.Provide the required external power supply to the stepper motor driver.
4.Connect the ESP32 Dev Kit to the computer using a USB cable and open the Arduino IDE.
5.Select ESP32 Dev Module and the correct COM port from the Tools menu.
6.0Open the stepper motor control program.
7.Compile and upload the program to the ESP32 Dev Kit.
8.Observe the stepper motor rotation after successful upload.
9. Verify the direction of rotation and step movement.
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Program:

1

2 #include <LiquidCrystal.h>

3

L L T — LCD ----—--——- *f

5 const int rs = 13, en = 12, d4 = 14, d5 = 27, d&6 = 26, d7 25;

6 LigquidCrystal lcd(rs, en, d4, d5, de, d7);

7 long stepCount = B8;

8

Q i*

16 v fidefine 4 - 15

11 5 2

12 6 32

13 7 =

14 !

15

16 ~ woid setup() {

17 pinMode(15, OUTPUT);

18 pinMode(2, QUTPUT);

19 pinMode(32, OUTPUT);

28 pinMode(4, QUTPUT);

21

22 // LCD init (ADDED)

23

24 led.begin{la, 2);

25 led.print{"Stepper Motor™);

26 )

27

28 ~ woid loop() {

29

ig /* Rotation in one direction */

31 for{int 1 = 8; 1 < 188; i++)

32 v |

i3 digitalWrite(4, HIGH);

34 digitalWrite(32, LOW);

i5 digitalWrite(2, LOW);

36 digitalWrite(15, LOW);

37 delay(1@);

i8 stepCount++;

39

1@ digitalWrite(4, HIGH);

11 digitalWrite({32, HIGH);

12 digitalWrite(2, LOW);

13 digitalWrite(15, LOW);

14 delay(18);

1% stepCount++,

16

AMOTECH Embedded/loT Development | Automation Sevices | Training & Counselling

LABS Embedded Development Boards/Kits |PLC & Automation Training Stations | 26

ey

E www.amotechlabs.com Q +91-8329537565 ™I amotechlabs@gmail.com



AMOTECH LABS

Sharing Enthusiasm for Embedded Systems & Automation.

47 digitalWrite(4, LOW);
48 digitalWrite(32, HIGH);
49 digitalWrite(2, LOW);
ca digitalWrite(15, LOW);
51 delay(18);

52 steplount++;

53

54 digitalWrite(4, LOW);
55 digitalWrite(32, HIGH);
56 digitalWrite(2, HIGH};
57 digitalWrite(15, LOW);
58 delay(18);

59 stepCount++;

{a2]

61 digitalWrite(4, LOW);
62 digitalWrite(32, LOW);
63 digitalWrite(2, HIGH);
64 digitalWrite(15, LOW);
65 delay(18);

66 steplount++;

67

&8 digitalWrite(4, LOW);
69 digitalWrite(32, LOW);
e digitalWrite(2, HIGH);
71 digitalWrite(15, HIGH);
72 delay(18);

73 steplount++;

74

75 digitalWrite(4, LOW);
76 digitalWrite(32, LOW);
77 digitalWrite(2, LOW);
78 digitalWrite(15, HIGH);
79 delay(18);

Ba steplount++;

81

82 digitalWrite(4, HIGH)};
83 digitalWrite(32, LOW);
B84 digitalWrite(2, LOW);
85 digitalWrite(15, HIGH);
86 delay(18);

87 steplount++;

283 }

89

ag lcd.setCursor(@, 1);

g1 led.print("Steps: ");

g2 led.print(stepCount);

93 led.print(” "Ys;

94

95 digitalWrite(4, HIGH);
96 digitalWrite(32, LOW);
97 digitalWrite(2, LOW);

98 digitalWrite(15, LOW);
99 delay(1@);
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188

181 /* Rotation in opposite direction */
182 for(int j = 8; j < 188; j++)
183 {

184 digitalWrite(4, LOW);
185 digitalWrite(32, LOW);
186 digitalWrite(2, LOW);
187 digitalWrite(15, HIGH);
188 delay(1@);

189 stepCount++,;

11@

111 digitalWrite(4, LOW);
112 digitalWrite(32, LOW);
113 digitalWrite(2, HIGH);
114 digitalWrite(15, HIGH);
115 delay(1@);

116 stepCount++,;

117

118 digitalWrite(4, LOW);
119 digitalWrite(32, LOW);
12@ digitalWrite(2, HIGH);
121 digitalWrite(15, LOW);
122 delay(1@);

123 stepCount++,;

124

125 digitalWrite(4, LOW);
126 digitalWrite(32, HIGH);
127 digitalWrite(2, HIGH);
128 digitalWrite(15, LOW);
129 delay(1@);

13@ stepCount++,;

131

132 digitalWrite(4, LOW);
133 digitalWrite(32, HIGH);
134 digitalWrite(2, LOW);
135 digitalWrite(15, LOW);
136 delay(18);

137 stepCount++;

138

134 digitalWrite(4, HIGH);
149 digitalwrite(32, HIGH);
141 digitalWrite(2, LOW);
142 digitalWrite(15, LOW);
143 delay(1@};

144 stepCount++;

145

146 digitalWrite(4, HIGH);
147 digitalWrite(32, LOW);
148 digitalWrite(2, LOW);
149 digitalWrite(15, LOW);
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158 delay(1@};
151 stepCount++;
152
153 digitalWrite(4, HIGH);
154 digitalWrite(32, LOW);
155 digitalWrite(2, LOW);
156 digitalWrite(15, HIGH);
157 delay(18};

158 stepCount++;

159 }

1@

161 led.setCursor(e, 1);

162 led.print({“"Steps: ");
163 led.print({stepCount);
14 led.print(™ ");

165

166 digitalkirite(d4, LOW);
167 digitallrite(32, LOW);
168 digitallirite(2, LOW);
169 digitalWrite(15, HIGH);
17@ delay(1a);

171

172
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Experiment 6
Wifi Time Update Interfacing

Aim: To study the Wifi time and Day update interfacing with ESP32 dev-kit and observe the output.

Circuit Dig:

Procedure:

e .,u.—.m;:r

[AMDTEEH 3S

WouTube u 1
Sharing Enthusiasm for Embedded Systems i ation. 8 Ted
Automation & Rebotics [TH <[ cumseiting| i voUtLbe. tcmiE_. :

i I

Video Description |
of UDB on e "

A

9 ‘ ps1307 RTC |
Module

SD Card
Module

SIMBOOL
GSM
Module

SERVO
. MOTOR

& Project/Product Dovelopmont ©

o 32-Bir pCu
5 Davkit V1 | Anduine Hano Boards | STMAZ Nano boards e
|

|}dbf; Pure

1. Connect the ESP32 Dev Kit to the computer using a USB cable.

2.0pen the Arduino IDE and select ESP32 Dev Module and the correct COM port from the Tools menu.
3.0pen the program for Wi-Fi—based time synchronization (NTP).

4.Enter the Wi-Fi network SSID and password in the program.

5.Configure the time server and update interval in the code.
6.Compile and upload the program to the ESP32 Deyv Kit.
7.0pen the Serial Monitor after successful upload.

8.0Observe the current date and time updated at scheduled intervals.

9. Verify that time is correctly synchronized via Wi-Fi.
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Program:

1 #include <WiFi.h>»

2 #include "time.h"

3 #include <LiquidCrystal.h>

4

5 // LCD pin configuration

6 LiquidCrystal lcd(13, 12, 14, 27, 26, 25);

7

8 £/ Wi-Fi credentials

9 const char® ssid = "Amotech Labs™;
18 const char® password = "123456789";
11
12 /f NTP settings
13 const char®* ntpServer = "in.pool.ntp.org";
14 const long gmtOffset sec = 19886; A IST
15 const int daylightOffset_sec = 8;
15
17 char TimeH M[&6];
18 char daystr[18].
19
28 void setup() {
21 Serial.begin(115288),;
22
23 lcd.begin{l16, 2);
24 led.clear();
25 led.print("Connecting WiFi™);
26
27 WiFi.begin(ssid, password);
28
29 while (WiFi.status() != WL_CONNECTED)
38 delay(1@88);
31 Serial.println{"Connecting to WiFi...");
32 lcd. setCursor{e, 1);
33 led.print("Please wait...");
34 }
35
36 Serial.println{"WiFi connected");
37 led.clear();
38 led.print("WiFi Connected");
39 delay(1668);
48 led.clear();
41
42 /f Initialize NTP
43 configTime(gmtOffset sec, daylightOffset sec, ntpServer);
44 1}
45
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46 void loop() {
47 printlocalTime();
48 delay(1e88); // update every second
49
ta
51 void printLocalTime() {
g2 struct tm timeinfo;
£3
54 if (lgetlocalTime(&timeinfo)) {
55 Serial.println({"Failed to get time");
56 lcd.clear();
57 led.print({"Time Error™);
L8 return;
59 }
ea
61 // Format time HH:MM
62 strftime{timeH M, sizeof(timeH M}, "%H:%M", &timeinfo);
63
64 // Format day name (Monday, Tuesday, etc.)
65 strftime{daystr, sizeof(daysStr), "¥A"™, &timeinfo);
66
67 // Display on LCD
68 led.clear();
69 led.setCursor(@, 8);
7@ led.print("Time: ");
71 led.print{timeH M) ;
72
73 led.setCursor(@, 1);
74 led.print{"Day: ");
75 led.print{daystr);
76
77 // Serial debug
78 Serial.print("Time: ™);
79 Serial.print(timeH M);
a8 Serial.print("™ | Day: ");
81 Serial.println{daystr);
82
83
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Experiment 7
RTC, SD card, ADC Interfacing

Aim: To Study Real-Time Data Logging Using RTC, SD Card, and 10k pot for Analog Input Interfaced

with ESP32 Using UDB.
Circuit Dig:
- RTC module
® AMDTEEH # Real Time Clock
Sharmg jsm :E'ra mﬁ?mms |
SD Card
Module

RELAY 3 ©

DC Motor
Connectors

10k pot as
Analog Input !
ENT BOARD(UDB) !
ectiProduct Development ™~ $52 225"
‘ Arduino Nano Boards | STM32 Nano boards ﬂ
Procedure:

1.Connect the RTC module, SD card module, and 10 kQ potentiometer to the Universal Development Board (UDB)
as shown in the circuit diagram.

2.Connect the ESP32 Dev Kit to the UDB and provide the required power supply.

3.Connect the ESP32 Dev Kit to the computer using a USB cable and open the Arduino IDE.

4.Select ESP32 Dev Module and the correct COM port from the Tools menu.

5.0pen the program for RTC, SD card, and analog input interfacing.

6.Compile and upload the program to the ESP32 Dev Kit.

7. After successful upload, rotate the 10 kQ potentiometer and open the Serial Monitor.

8.Observe the real-time clock data and corresponding analog input values.

9. Verify that the data is correctly logged into the SD card.
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Program:

1 i*

2 Aim:

3 To study real-time data logging using RTC, SD card,

4 and 18k potentiometer for analog input using ESP32 Dev Kit

5 «/

6

7 #include <SPI.h>

8 #include <5D.h>

9 #include <Wire.h>

18 #include <RTClib.h>

11 #include <LiquidCrystal.h>

12

13 ff e Pin Definitions ----------------

14 #define 5D _C5 5 ff 5D card C5 pin

15 #define POT_PIN 34 /f ADC pin for 18k pot (ESP32)

16

17 /f LCD pins: RS, EN, D4, D5, D&, D7

18 const int rs = 13, en = 12, d4 = 14, d5 = 27, d& = 26, d7 = 25;

19 LiquidCrystal lcd(rs, en, d4, d5, d6, d7);

28

21 ff e Objects ----------------

22 File myFile;

23 RTC_DS3231 rtc;

24

25 - Setup ----—--—-——----—-—-

26 void setup() {

27 Serial.begin(968@);

28 delay(lees);

29

38 // LCD initialization

31 lcd.begin(16, 2);

32 led.clear();

33 led.print("System Ready”);

34 delay(1568);

35 led.clear();

36

37 /f 12C for RTC

38 Wire.begin();

39

48 // Initialize RTC

41 if (Irtc.begin()) {

432 lcd.print("RTC Error"});

43 Serial.println{"Couldn't find RTC"};

44 while (1);

45 I

45
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46

47 f// Set RTC time if power was lost

48 if (rtc.lostPower()) {

44 rtc.adjust(DateTime(F({__DATE_ ), F{__TIME_ }));
58 }

t1

52 {/f Initialize SD card

53 led.print("SD Init...");

54 Serial.print{"Initializing SD card...");

55 if (!1SD.begin(SD_C5)) {

56 lcd.clear();

57 lcd.print("SD Failed");

58 Serial.println({"Initialization failed!");
59 while (1);

66 }

61 Serial.println{"Initialization done.™);

62

63 led.clear();

64 led.print("SD Ready™);

&85

66 {/f Create file and write header

67 myFile = SD.open("DATA.txt", FILE_WRITE};
68 if (myFile) {

69 myFile.println{"Date Time Analog Valus");
78 myFile.close();

71 }

72

73 delay(1eee);

74 led.clear();

75

76

77 e e e Log Time ----------------
78 void loggingTime() {

79 DateTime now = rtc.now();

88

21 myFile = SD.open("DATA.txt", FILE_WRITE};
az it (myFile) {

a3 myFile.print(now.year());

24 myFile.print("/");

85 myFile.print({now.month());

36 myFile.print("/");

a7 myFile.print(now.day());

a3 myFile.print(" ");

a9 myFile.print(now.hour());

ag myFile.print(":");

91 myFile.print(now.minute());
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g2 myFile.print(":");

93 myFile.print(now.second()});
g4 myFile.print(" ");

a5 myFile.close();

96 }

a7

a8 {/f LCD display - Date & Time

99 led.setCursor(@, @);
lee led.print(now.day());
181 ledoprint('/);
182 led.print(now.month());
183 led.print('/");
le4 led.print(now.year());
185
186 led.setCursor(@, 1);
187 led.print(now.hour(});
188 led.print(':");
1ea led.print(now.minute());
118 led.print(':");
111 led.print(now.second());
112
113 /f Serial Monitor
114 Serial.print(now.year(});
115 Serial.print('/");
116 Serial.print(now.month());
117 Serial.print('/");
118 Serial.println(now.day());
119 Serial.print(now.hour()};
12@ Serial.print(':");
121 Serial.print(now.minute());
122 Serial.print(':");
123 Serial.println(now.second());
124}
125
126 ff ————mmmmmm - Log Analog Value ------------—-—---
127 void logginghnalog() {
128 int analogValue = analogRead(POT_PIN);
129
138 Serial.print("Analog Value: ");
131 Serial.println{analogValue);
132
133 myFile = SD.open{"DATA.txt", FILE_WRITE};
134 if (myFile) {
135 myFile.println{analogValue);
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135 myFile.println{analogvalue);
136 Serial.println{"open with success");
137 myFile.close();
138 }
130
148 f/ LCD display - Analog value
141 led.clear();
1437 led.setCursor{@ , 8);
143 led.print{“analog Value™);
144 led.setlursor(@, 1);
145 led.print{analogValue);
146  }
147
148 Ho-—————— Loop ----------------
149 void loop() {
158 loggingTime();
151 delay(2888);
152
153 logginginalog();
154 delay(3888); /f Total logging interwval = 5 seconds
155 led.clear();
156 1
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